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otaloger eneiv anigap rep otof id oremun 1I horizontally and vertically through the center of the image (full-format fisheye lenses) is cropped to match the image angle of the camera. Click the button to enter Color Control Point mode (to exit Color Control Point mode, click the button again). Page 22 To change the default behavior of Capture NX-D,
select Preferences in the Composition menu (or, on Mac computers, the Capture NX-D menu). Designed specifically for RAW image processing, Capture NX-D provides responsive and intuitive controls. Page 12 Dust and scratches can be removed using the Touch Up Brush tool. Click the Settings Manager icon and select Copy Changes or Copy All
Image Settings from the Options in the Settings Palette. Version 1.0 is now available for download. This also applies to images cropped using ViewNX 2 or ViewNX-i. Unsupported Images Images that have been edited using the Efex Pro Color plug-in for Capture NX or Capture NX 2 can be fine-tuned in Capture NX-D by first resetting all changes
using the Reset button in the edit pane. The Picture Control “Auto” Parameters for the Picture Control Auto can be set to values from A2 to A+2. You can choose the adjustment sliders displayed from the Color Template menu for the Color Control Point tool in the touch-up palette. Click on the icon and choose a rating from (no rating) to five stars.
Drag the cursor over the image to select the crop. Image sizes are automatically adjusted according to the selected options. Fine adjustment of the white balance can be made using the Color Temperature and Hue commands in the palette el ettut atropsE a ehcifidom atropsE inoizpo eL retupmoc irtla never inoizaloger id aipoC .asecsid and unem la
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NIEANIE NIAI Etnnmacitamotua innarv iniggami elp.ittrus ulin otiplei atif ati-eozi-enopuc- onacilppa is ehc ocnaib leed otnmaici lizel'l ¢ xn iop iop iop zeap o Pied Inigami El Fen Seisrevnoc ertla Duelappi, ARAZAEO AEI.1+ ELAIZAYO AIEO NIAISUE salvano le regolazioni immagine in un file che puA2?A essere copiato su altri computer. Fare clic
sull'icona manager regolazioni e selezionare Incolla regolazioni dalle opzioni nella tavolozza regolazioni. Fare clic sul pulsante per visualizzare la barra filtri. Selezionare le foto. Opzioni di elaborazione batch sono mostrate di seguito. Trascinare le maniglie dei cursori di regolazione verso sinistra o verso destra per regolare il colore selezionato. Fare
clic su Avvia per copiare il file o i file nella cartella selezionata. stata scattata la foto. Selezionare o deselezionare Pennello di ritocco automatico per mostrare o nascondere gli effetti del pennello di ritocco o annullare gli effetti del pennello facendo clic su Elimina. Fare clic su Reimposta per ripristinare tutti i cursori. Lo strumento manager regolazioni
Il manager regolazioni puA?A essere utilizzato per applicare piA'A regolazioni contemporaneamente. Per nascondere gli effetti del raddrizzamento, rimuovere il segno di spunta dalla casella di controllo Raddrizzamento. Page 13 Utilizzare lo strumento nella barra degli strumenti per schiarire, scurire o modificare in modo selettivo i colori. Riduzione
disturbo Selezionare questo strumento per visualizzare i comandi di riduzione disturbo nella tavolozza di regolazione immagine (vedere sotto). Le opzioni disponibili per Metodo variano con la fotocamera utilizzata per creare l'immagine attuale. Page 10 Regolare luminositA A e contrasto complessivi oppure effettuare regolazioni che influiscono solo
sulle alte luci e sulle ombre. Fare clic su per visualizzare solo le immagini protette, su per visualizzare solo le immagini non protette. Gli utenti Nikon non dovranno disperare, anzi: sono integrate infatti tutte le funzioni di visualizzazione di ViewNX-i e di elaborazione e ritocco di Capture NX-D, ora fruibili tutte in un unico ambiente di lavoro per
un'ottimizzazione delle attivitA A. Capture NX-D ? Le immagini RAW opened in Capture NX or Capture NX 2 will be restored to the state they were when they were last saved in these applications, regardless of the changes you made in the meantime using Capture NX-D. what did you want to make when ? Available parameters vary with the camera
used and with the color reproduction process and Picture Control selected. available for free download on the website? Choosing values closer to 1 with full-format fisheye images will cause sections that do not contain image data and are filled with the selected color in the Fill Color menu. Previous Picture Control If the Color Playback menu offers a
choice between Last Picture Control System and Camera Compatible, the parameters listed below will be available when Camera Compatible is selected. If no message is displayed, proceed to step 3. Note that Contrast and Brightness cannot be adjusted for Picture Controls that use a custom curve. Page 3 To make it easier to sort and locate images,
you can assign them labels from “0” (no label) to “9”, each with its own unique color. Choose the proportions in the clipping palette (to select a free clipping without fixed proportions, choose Free Crop). Protection can be added or removed via the Protect Thumbnail icons or Protect File in the Image menu option. General Colour Management
Perceptive Intent maintains relationships between colours to produce results that appear natural to the human eye. To straighten images manually, click Straighten in the image adjustment palette and drag the cursor parallel to a line in the preview (this option cannot be used with thumbnails). Here we have set the Exhibition on +1.50. The settings
for these tools can be selected from the drop-down menus. The drop-down menu in the Tools list offers a choice of pre-mixed values. The buttons for the tools that have been modified compared to the default values are highlighted in yellow (eg protected images cannot be deleted or renamed. It is also possible to adjust the following entries: quality
best 2013 Select Quality Best 2013 allows you to make separate adjustments of intensity and sharpness for luminance and color (RAW images only). Print note to print on a JPEG file, click Print on file. Canceling the color control point selection to cancel The selection of the current color control point, click on it by holding down the Ctrl (or, on Mac
computers, the key / command) or choose Cancel the selection in the Composition menu. Page 16 to save RAW images (NEF / NRW ) in JPEG or TIFF format, click on the button in the toolbar. The illustration shows the slider luminosity used to adjust the brightness of the sky: the effect applies only At the blue of the sky, leaving the color of the
unaltered building, and is reduced with the distance from the control point. This option can be used, for example, to illuminate the blue of a dark sky. Does the software? The white balance for the entire image will be adjusted so that the selected area or pixel takes a neutral gray color. Straightening / distortion perspective Straighten the images or
correct the effects of perspective. If we have selected copy changes to Step 2, exposure compensation and picture control for the selected image would have been set to the values selected at step 1, while the white balance would remain at the value selected at step 3. The Distortion Control cursor controls the distortion. To select two photos and all
images between these, click on the photos while pressing the Shift button. Enter a name for the new setting and click OK. Brush size A brush more great than the defect you are trying to correct could affect the surrounding areas of the image. Prospective distortion Correct LA ¢ & € ™ Effect of perspective, for example, on photos taken with the
camera angled high to frame a high building. Select Registration Manager from the drop-down menu to display a dialog where you can rename or delete previously saved settings. Click Edit ¢ 4 € A|. Copylng the copy and paste color control points can be used to create more control points with the same size and the same type of effect. Print Photo
Information Print Photo Information is not rotated when you rotate and appropriate is selected in the "Print" dialog box. The Color Process can also be selected using the Color Process option on the A ¢ & € aceThe Nef (RAW) tab A ¢ 4 € 4 € 4 € ¢ preferences dialog box. The settings in the "Improvement Step" section of Capture NX or "Step" of Capture
NX 2, however, cannot be adjusted separately, although they can be hidden if necessary to obtain the desired result. To remove protection, click the Protect (Time) icon again. Keeping the mouse button pressed, drag the brush over the defect. The same procedure can be used to add settings to the drop-down menu in the retouch palette. Tint can be
set to values between A ¢ 4 € 4 € ce 12 and +12: choose lower low values to get less green and more magenta, higher values for the opposite effect. The effect is checked Cursors: a slider Size that controls the extension of the selected area and (to the default settings) three adjustment sliders for adjusting brightness, contrast and saturation in the
selected area. The Italian manual must be necessary as the men? LA ¢ & € ™ high resolution allows later to modify the photographs by obtaining photographs of altolivello. Levels and sampling RAW processing display Open in application Dialog windows Page 23 Copying and saving adjustments The conversion of images into JPEG or TIFF format
prevents any previous adjustments to be copied or saved. Adding control points in practice, the maximum number of control points that can be added to a single image is about 100. Adjust the settings as described for entries from up to in A ¢ & € AceLaboration BatchA ¢ &4 € 4 € A. Nikon expressly cites functions like picture control, white balance,
exposure compensation for RAW files, color control points to adjust the color within a specific area, the retouching brush, the application of the edit tools from Apply (also) to JPEG / TIFF images and loading images on the web.Insomma, it is a new intuitive tool that allows Nikon photographers to have everything under control evenly more than just
than before: AfA You can also quickly transfer photos to Nikon Image Space and is expected to compatibility with Nikon Transfer 2 software and Camera Control Pro 2. The Color Control Point Tool The Color Control Points can be finely adjusted Using the color control point tool in the retouch palette. In order to use the program in the midst of its
functionality? All items except tone / tone (details) apply exclusively to RAW images (NEF / NRW). Follow the steps below for images. Capture NX-D automatically chooses the affected area based on the location of the control point. The effect is applied to the area indicated by a dashed line and is reduced by the distance from the control point. Using
Color Control Points Follow the steps below to add and adjust color control points. The automatic touch brush The touch brush copies the data from the surrounding areas of the A @ AAimage and automatically pastes it to the defect. The available Picture Controls vary depending on the option selected. WillA A dialog box appears in which AA" you
can select the filters. Using "Reset Shooting State" with images edited in other applications In the case of JPEG and TIFF images edited in Capture NX 2 or ViewNX 2, Reset Shooting State returns the image to its last saved state. continueA Download the Italian Capture NX-D software manual. The adjustments copied to step 2 are applied to the
images selected in step 3. Use the navigation palette or zoom commands in the View menu. Click a tools button or icon in the tools list to view the settings for the selected item. Select a tool from the toollist and adjust the settings in the adjustment palette. Advanced Photo Information Printing Settings Page 20 To print multipleA! images per page,
select Index Print for "Print Type" in the "Print" dialog box. After you enable noise reduction by placing a check mark in the Noise Reduction check box, adjust the settings as described in this section. The range of available Color Temperature values varies depending on the white balance option selected. Repeat steps 2 to 4 to add control points Non
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KO us cilc eraf e otnemirefir id elif nu eranoizeleS .ilanigiro enigammi itad ia iledef To the outside, while the lowest values curve it towards the inside. ? The affected area is indicated by a translucent red line; Continue to completely cover the defect. Labels are assigned using miniature label icons or the label option in the Image menu. A ¢ 4€ A€ 4 €
Protect fileA ¢ & € & € files can also be protected or the protection can be removed by selecting protect or remove protection to protect files in the image menu. The drop-down menu in the Tools list can be used to choose from values between +1.0 and A ¢ 4 € 4 € ce 1.0 EV. Related map The colors that are not in the profile selected to the color
available closer. The bends do not contain image data and are filled with the color selected in the Fill Color menu. Image dust off dust changes day position in day; If possible, use the reference data recorded in the last 24 hours. Adjust the settings as described on the following page and click Print to print the image as shown in the preview. AF-S
Fisheye Nikkor 8-15 mm f/ 3.5-4.5e and cursor size cutout controls the cutout size. The contrast of the edges increases while other areas remain unchanged. Here we set the exposure compensation to A ¢ 4 € 4 € ce 1/2 Ev and selected the saturated Picture Control. Cutout The clippings are not applied to the original image data and can be changed at
any time by clicking the button in the toolbar. Click the image to add a color control point and drag it to the area you want to change. Straightening Straighten Images up to AA + 10AA °. Camera / Lens Corrections Select this tool to view the following commands in the image adjustment palette: Image Dust Off Follow the steps below to perform
Image Dust Off. 14 Image adjustments can be copied and applied to other photos, speeding up the process of improving images taken under similar conditions. If the only option available is Camera-compatible, the remaining settings can be adjusted as follows: If the Method menu is available, choose Faster for faster processing or Better Quality 2013
(RAW images only) or Better Quality for more noise reductionAl accurate. A dialog box will appear where you can choose a file format and adjust settings such as compression and image size. Fine-tune the settings using the sliders or select Automatic (Automatic) to allow Capture NX-D to adjust the settings automatically (note that Automatic
(Automatic) produces results that may vary depending on the exposure as well as the position and size of the subject in the frame). The options in the “Page Layout” area will change; choose the number of images printed per page. Color Brightness Adjust the brightness of selected colors without affecting color saturation or hue. In this example, the
selected image has already been adjusted using the Exposure Compensation and White Balance tools. Color Process Parameters Picture Control Color Process Choose from the options below. Page 18 To print images to a printer connected to your computer, select the photos and choose Print from the File menu. Click Start to start processing and
display a progress dialog. Dust off image is not available with NEF (RAW) format images saved at a Small image size setting. Sliders can be adjusted by dragging the handles (A¢AA) to the left or to the right or by positioning mouse cursor on a handle and rotating the scroll wheel. To run Image Dust off using the file in the current folder, select Yes.
Download the Italian Capture NX-D Software Manual from the following link: Download Capture NX-D Nikon announces NX Studio, new completely free software for Windows and Mac to view, edit and edit photos and videos. “Classification” Selected files can also be classified using the Classification option in the Image menu. Page 15 To crop the
unwanted areas from the images, click the button on the toolbar. Instructions, examples, guides for processing photos in ?RAW Capture NX-D format? Click on a label (; for images without a label, the label “0” only appears when the cursor is above the image) and choose a label from “0” (no label) to “9” (). offers cleaning of the image sensor, use only
the data recorded after the most recent cleaning, as cleaning can change the location of the dust. The image will be rotated up to A+=10 A° to make the reference line horizontal or vertical and the degree of rotation will be displayed in the text box in the image adjustment window. The “Print” dialog Page 19 To choose the information printed under
each image, select Print Photo Information in the “Print” dialog box, click Settings, and adjust the settings described on the next page. The image below has been modified using the Picture Control tool in the “Develop” section and the Blur Control tool in the “Rule” section of CaptureA NXA 2. An ideal opportunity to put in order what you learned
during the video course of photography that Nikon made available free of charge until last December. Select the photos. inigammi el eratropse idniuq e atanoizeles alletrac anu ni etunetnoc inigammi el ettut us enigammi inoizaloger essets el eriugese rep atazzilitu eresse 2AAup hctaB > eliF enoizpo'L 71 egaP .)aticsu( elanif enigammi'llen iroloc id
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selected file format. The RAW image format (NEF/.NRW) allows you to get photos from SLR cameras with the highest resolution. and the configurations are so many that without an instruction booklet it is impossible to use all the features. Select Record Manual Setup from the drop-down menu in the tool list. The most recently used settings are
recalled when the print dialog is displayed the next time. Copying Adjustments to Other Images Follow the steps below to copy the adjustments and apply them to other images. One application could be to delve into the colors of a pale blue sky. Unless you select Include areas without image data, the image will be automatically cropped to remove any
blank corners. Double-click inside the crop or click the Apply button on the toolbar to crop the image. Note that some of these tools can only be used with RAW images (NEF/NRW); for more information, see the section for each tool. exposure in the image adjustment palette. The image adjustment palette also offers an active D-Lighting menu that can
be used to highlight details in high lights and shadows. The progress can be displayed in the Queue and Processed tabs. The perspective can be adjusted vertically and horizontally up to £20. Adjustments can be made on the whole image or on specific parts of the tone range (for example, the range of a printer, monitor, or other specific output
device), allowing you to make improvements without sacrificing details. Copying adjustments from RAW images to JPEG or TIFF images When adjustments are copied from RAW images a immagini JPEG o TIFF, la compensazione dell'esposizione, i Picture Control e altre impostazioni che sono disponibili solo con le immagini RAW non verranno
applicate. Margini pagina Scegliere la larghezza dei margini pagina. Per selezionare piA'A immagini, tenere premuto il pulsante Ctrl (o, sui computer Mac, il pulsante /comando) mentre si fa clic di seguito su ciascuna immagine. I ritagli sono applicati quando le immagini vengono convertite a JPEG o TIFF. Se si selezionano piA!A classificazioni,
verranno visualizzate tutte le immagini con classificazioni che rientrano nella gamma selezionata. Il pulsante Ripristina Fare clic sul pulsante Ripristina (¢AAARipristina stato di scatto¢AAA) per reimpostare tutti gli strumenti e ripristinare 1'immagine allo stato in cui era quando A"A stata aperta per la prima volta in Capture NX-D (si noti che le
eventuali modifiche apportate alle immagini JPEG e TIFF in altre applicazioni dall'ultima volta in cui erano state aperte in Capture NX-D non saranno reimpostate). Per esempio, selezionare classificazioni da tre a cinque stelle per visualizzare le immagini con classificazioni di tre, quattro e cinque stelle. Con altre impostazioni, un segno di spunta ()
appare nella casella a destra del menu a discesa e le modifiche possono essere nascoste togliendo il segno di spunta dalla casella (). Filtri Le opzioni per i filtri Modello, Lunghezza focale, Tempo di posa, Diaframma e SensibilitA A ISO sono limitate ai valori trovati nelle immagini nella cartella corrente. Colonne e righe Scegliere il numero di colonne e
di righe stampate per pagina (il minimo A"A 1 e il massimo 10). Lo strumento manager regolazioni Usare lo strumento manager regolazioni per copiare le regolazioni ad altre immagini o salvare le impostazioni correnti per un uso futuro. Aggiunta di regolazioni al manager regolazioni Utilizzare le opzioni Registra modifiche e Registra tutte le
impostazioni immagine per aggiungere le irolav rep .otof e eranozeles .otanoizeles eauq, ODNAIZE ERUZIPS ERUZAIZE ERUZIOCK EASTNIPT HOURNIB LED EUTLEVILY EASTNIB LED ODNAIB ALSOKSOP HISEZASEPMACE AL, 2 PETS ONTLACSAIOVEIR AL ELIOTHJATIOR AL Elikgat aluso OTCOOVATIIR AL Elikgat ALSUBIOVATIIR AL Elikgat

ELIPOZELes Eliao AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAID OTEMUN THE OTINIFFERP OTAMROF OTMOGILIZA.SAIZAVIFIQUIQUALS EHC EHCHACIOVEF ORIZAVIFIQUALS EHC EDNAIDECE EHC EHCHEMS OBTAGILY GNITHGILY ELAIZMA EDAIZNETA ELAIERCRIPAF ALL OLDGARG ALL
A¢ FRARG NO .2 TPARGER ALL OLDECON NO'S , D-xn erutpac ni) wrn (war ingamas her Ehcifid-Ehcifid Ehcifid-Ehr / Fen (war integamasa reganam LED AsECSID to UNEM LA tra +5,0 e ¢AAA5,0 EV, aumentati in step di 0,01 EV, utilizzare il comando Comp. Trascinare gli angoli del ritaglio per ridimensionarlo senza modificare le proporzioni.
Parametri Picture Control Dopo aver scelto un processo di riproduzione del colore, scegliere un Picture Control e regolare i parametri Picture Control. Il menu a discesa nell'elenco strumenti offre una scelta di Picture Control premisurati. Altrimenti, selezionare No e procedere allo step 3. Saturazione colore Aumentare o diminuire la saturazione
colore sull'intera immagine o su una parte della gamma colore, rendendo i colori piA!A o meno saturi. Il colore e la spaziatura della griglia possono essere selezionati nella scheda ¢AAAVisualizzazione¢AAA della finestra di dialogo delle preferenze. "Etichette" I file selezionati possono essere classificati anche utilizzando 1'opzione Etichetta nel menu
Immagine. Utilizzare il cursore per scegliere il livello di applicazione. Potrebbe non produrre i risultati desiderati se i difetti sono molto diffusi, lo strumento viene trascinato per una lunga distanza o I¢AAAoggetto interessato A“A molto grande. L¢AAAarea esterna al ritaglio viene visualizzata in grigio. Le immagini che sono state modificate utilizzando
Color Efex Pro sono indicate da icone nell'elenco miniature. Page 2 Alle immagini possono essere assegnate classificazioni da (nessuna classificazione) a cinque stelle. Le proporzioni possono essere modificate dopo aver ridimensionato e posizionato il ritaglio. Page 6 La maggior parte delle regolazioni immagine viene eseguita usando la tavolozza di
modifica, che A"A composta da un elenco strumenti, una tavolozza regolazioni e pulsanti strumenti. L'elenco strumenti L'elenco strumenti contiene le voci elencate di seguito. Regolare la dimensione del punto di controllo trascinando la maniglia del cursore dimensione a sinistra o a destra: piA'A A”A lungo il cursore, piA'A ampia A"A I'area
interessata. I comandi nella Image adjustment can be used to choose a color process, make quick adjustments to the selected command, or fine-tune individual Picture Control parameters. Clicking the button on the toolbar displays the touch-up brush palette. Choose lower values to rotate the image to the left, higher values to rotate it to the right.
Page 8 Adjust the white balance. AF DX Fisheye-Nikkor 10.5 mm f/2.8G ED and AF Fisheye-Nikkor 16 mm f/2.8D If checked Include areas without image data, the image will not be cropped; instead, some sections of the image will be folded. Only images that meet at least one of the selected criteria will appear in the thumbnail list. The smaller the
crop, the more the center of the image will be magnified. magnified.

30/01/2017 - Scarica il tuo manuale italiano PDF. Districarsi nel mondo dell’ High Tech, molte volte, risulta particolarmente difficile senza l'utilizzo di un Manuale che ci aiuti a comprendere tutte le funzioni del dispositivo che stiamo utilizzando. Il nostro Blog ha pensato di costruire una pagina dedicata al ” Manuale PDF “, ” Guide e Istruzioni “, ”
Manuali d’uso “, ” Manuale ... Nikon Capture NX-D viene fornito in boundle con 1'acquisto delle fotocamere Aps-c e Full Frame di Nikon. Per l'installazione dovete disporre del disco fornito con la fotocamera. Sul sito Nital esiste la possibilita di scaricare gratuitamente il programma. Vorrei sottolineare che questa & una gulda all'uso, non un manuale di
istruzioni. Para mas informacion sobre el uso de este software, seleccione Ayuda Capture NX-D en el menu Ayuda de Capture NX-D. Cambios de la versién 1.6.4 a 1.6.5 * Se ha solucionado un problema que evitaba que el software abriese imagenes grabadas con un iPhone 12 (la extension debe cambiarse de “.JPEG” a “.JPG”). Scarica Capture NX-D
ora. Specializzato per lo sviluppo delle immagini in formato RAW con elaborazione dello sviluppo nativa che assicura le prestazioni di base della fotocamera Nikon. Supporta la semplice modifica delle immagini JPEG e TIFF. Tavolozze mobili facili da usare con un monitor di grandi dimensioni e con piu monitor. Capture NX-D lets you fine-tune pictures
by, for example, adjusting brightness and hue, and can also be used to edit RAW images taken with Nikon digital cameras and save them in other formats. Fine-Tune Pictures. With Capture NX-D, it’s easy to adjust such settings as brightness and white balance (page 18). Certain settings, such as exposure ... Step 2: Launch NX-D and navigate to the
imported NEF file on your computer. Step 3 There's no step 3, you've started. I took a shot of Melty as an example. I decided to use my Nikon 1 J1 instead of my DSLR to get more of a challenge, which ... Scarica il Manuale italiano del software Capture NX-D dal seguente link : Download Capture NX-D. Ritornare alla prima pagina di . Tweet. Vedi
articolo originale. Segnala un abuso. A proposito dell'autore. Allmobileworld 11305 condivisioni Vedi il suo ... About Capture NX-D. Capture NX-D photo processing software lets you realize the full potential of your Nikon digital camera and lens, producing images with the unsurpassable quality envisioned by our designers. It offers features
specifically designed for post-processing of RAW images and provides them in an intuitive, easy-to-use form.
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